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Read Me First
Welcome to Take Control of Apple Mail, Third Edition, version 3.0,
published in September 2015 by TidBITS Publishing Inc. This book
was written by Joe Kissell and edited by Dan Frakes.
This book helps you understand the most effective ways to use Apple’s
Mail app in OS X 10.11 El Capitan and iOS 9, including customization
and troubleshooting. It also helps you manage your incoming and
outgoing email efficiently.
If you want to share this ebook with a friend, we ask that you do so
as you would with a physical book: “lend” it for a quick look, but ask
your friend to buy a copy for careful reading or reference. Discounted
classroom and Mac user group copies are available.
Copyright © 2015, alt concepts inc. All rights reserved.

Updates and More
You can access extras related to this ebook on the Web (use the link
in Ebook Extras, near the end; it’s available only to purchasers). On
the ebook’s Take Control Extras page, you can:
• Download any available new version of the ebook for free, or buy
any subsequent edition at a discount.
• Download various formats, including PDF, EPUB, and Mobipocket.
(Learn about reading on mobile devices on our Device Advice page.)
• Read the ebook’s blog. You may find new tips or information, as
well as a link to an author interview.
If you bought this ebook from the Take Control Web site, it has been
added to your account, where you can download it in other formats
and access any future updates. However, if you bought this ebook
elsewhere, you can add it to your account manually; see Ebook Extras.
3
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Basics
To review background information that might help you understand
this book better, such as finding System Preferences and working with
files in the Finder, read Tonya Engst’s free Read Me First: A Take
Control Crash Course, available on the Web or as a standalone ebook
in PDF, EPUB, and the Kindle’s Mobipocket format.

What’s New in the Third Edition
This fully revised third edition brings the book up to date with the
numerous changes in Mail running under OS X 10.11 El Capitan and
iOS 9. As a result, most of the new material is referenced in the chapter
Learn What’s New in El Capitan and iOS 9 Mail. In addition to topics
mentioned in that chapter, this edition adds:
• An entirely new chapter, Extend and Automate Mail, which discusses the use of plug-ins, add-ons, AppleScript, and Automator
• A new sidebar for those setting up encryption in Mail: Using the
Same Certificate on Multiple Macs
• A sidebar called About the Activity Window, which describes the
new way El Capitan shows activity
Note: For help with Mail in OS X 10.9 Mavericks and iOS 7, you can
download the first edition of this book; for OS X 10.10 Yosemite and
iOS 8, you can download the second edition. To find the older editions, visit Ebook Extras on the Web and look under the Blog heading.
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Introduction
If Apple Mail is your email client of choice under OS X 10.11 El Capitan
or iOS 9, as it is for me, this book will help you get more out of it. You’ll
understand the app better, learn useful tricks and techniques, and
even become a more effective correspondent. I hope and expect that by
the time you finish this book, you’ll be a much happier Mail user than
when you started.
Of course, merely installing El Capitan may improve your happiness!
The versions of Mail in Mavericks and Yosemite had a lot of shortcomings, and were widely (and justifiably) criticized. In El Capitan, Apple
has clearly taken that criticism to heart, and has made Mail more
reliable, faster, and easier to use. Don’t get me wrong; Mail has not
been rethought from the ground up as I would have liked, and some
of its longstanding irritations remain. But it’s pretty darn solid now.
Where trouble spots remain, I help you to avoid, fix, or work around
them. And I tell you what I’ve done to make Mail work better for me. I
also help you get more out of Mail, enhance your email workflow, and
much more.
It’s also worth noting that even though I’ve written books about Mail,
I have no particular allegiance to it as an app. I just want the best
email tool I can find for my particular needs. So I’ve tried quite a few
alternatives—with an open mind and a complete willingness to jump
ship if I found something better. The thing is, even at its worst, I still
liked Apple Mail the best. Given the way I’ve customized my settings,
and the third-party plug-ins I’ve added, I haven’t yet found another
app that gives me all the capabilities I’ve come to depend on in Mail.
It’s like that favorite pair of jeans that you still wear despite the odd
tear or stain. I hope you’ll feel the same way after reading about the
many ways you can improve on Mail’s out-of-the-box state.
Mail under iOS, while less powerful, is remarkably good and getting
better all the time. The biggest issue with iOS 9 Mail is that, like most
mobile email clients, it still lacks many of the useful features found in
5
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the desktop version, which means iOS users will need to develop a
strategy that takes those differences into account.
Regardless of whether you use El Capitan, iOS 9, or both, this book
is about how to do useful things with Mail—how to bend Mail to your
will (to the extent possible) and feel as though you are genuinely in
control of your email. Along the way, I’ll show you how to do more
with the parts of Mail that work, and I’ll identify and tell you how to
deal with as many problems as I can. But this isn’t a comprehensive
reference guide: I’ll largely ignore basic tasks that you either know
how to do already or can figure out easily by consulting the Help menu.
I’m assuming you already know your way around an email client and
mainly want guidance with less-than-obvious tasks and features.
Several chapters apply equally to Mail in El Capitan and iOS 9, but
most of the book focuses on Mail in El Capitan, which is only right,
since it has far more features (and problems) than the iOS version.
The final chapter, Use Mail in iOS 9, covers the differences between
the two platforms as well as the special strengths, weaknesses, and
idiosyncrasies in the iOS 9 version of Mail.

6
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Apple Mail Quick Start
Although you can jump directly to any topic of interest, I suggest
starting with the first few chapters to get a solid foundation. Chapters
are marked with [OS X] and/or [iOS] to show the platforms they cover.
Understand what you’re dealing with:
• Discover Mail’s new features and design changes. Read Learn
What’s New in El Capitan and iOS 9 Mail. [OS X/iOS]
• Get a grip on POP, IMAP, SMTP, Exchange, and more as you Learn
about Email Protocols. [OS X/iOS]
• Make sure you understand account-setup details and how Mail
deals with common tasks. See Master Mail Concepts. [OS X]
Find the ideal Mail setup for your needs:
• Tailor Mail to your needs and tastes with settings, shortcuts, plugins, and more as you Customize Mail. [OS X]
• Take Mail even further. See Extend and Automate Mail. [OS X]
• Gmail user? You’re in for some weirdness, so there’s a whole chapter just for you: Use Gmail with Mail. [OS X]
Become a better Mail user:
• Search like a pro. Read Find Your Messages. [OS X]
• Manage incoming and saved messages as you Take Control of Your
Inbox, and then learn the best ways of sending and replying to email
in Become a Better Correspondent. [OS X/iOS]
Handle exceptional tasks:
• When privacy is a priority, Sign and Encrypt Messages. [OS X/iOS]
• Perplexed by an error message or other misbehavior in the Mac
version of Mail? Read Fix Mail Problems. [OS X]
• Make the most of Mail on your iPhone, iPad, or iPod touch. See Use
Mail in iOS 9. [iOS]
7
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Learn What’s New in
El Capitan and iOS 9 Mail
The El Capitan and iOS 9 versions of Mail contain useful new features
and design changes. Skim over this chapter to see which of these
changes may be important to you.

Mail Changes in El Capitan
The El Capitan version of Mail looks almost identical to its OS X 10.10
Yosemite predecessor at first glance, but it’s much different underneath. Here are the major changes I think you should be aware of:
• Gesture support: Using a trackpad, you can now swipe across
items in your message list with two, three, or four fingers to navigate, mark as read/unread, delete, or archive. See Gestures.
• Full-screen improvements: In Full Screen mode (including
Split View), it’s now possible to minimize messages you’re composing within Mail and navigate to other messages without having to
save and later reopen a draft. See Full Screen Mode.
• Better alias handling: Mail now offers a convenient built-in
interface for adding aliases to any compatible account. See Configure Alternative From Addresses.
• Improved Data Detectors: In El Capitan, Mail makes it much
easier to see and work with contact and calendar data found in
messages. See Data Detectors.
• Natural language searching: You can now search just by asking
Mail for what you want. See Perform a Natural Language Search.
• Under-the-hood improvements: Mail in El Capitan fixes quite
a few bugs. It also improves performance markedly, and includes a
rewritten IMAP engine that’s faster and smarter, downloading the
messages you’re most likely to need now before syncing older ones.
8
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Noteworthy Changes in Yosemite and Mavericks
If you skipped Yosemite or Mavericks, you may be unaware of the
many changes Apple made to Mail in the two prior releases of OS X.
I won’t detail them all here, but a few are worth knowing about.
Added in Yosemite:
✦

✦

✦

✦

Mail Drop: Mail Drop lets you send large attachments painlessly
by automatically storing them in iCloud and putting links to them
in your messages. See Mail Drop.
Markup: This feature enables you to annotate or sign a graphic or
PDF in an outgoing email message. See Markup.
Handoff: Start composing a message on one device (Mac or iOS)
and continue it on another with a click or a tap. See Handoff.
Automatic setting detection: Lets Mail figure out settings for
authentication, port, SSL, and the like. See the sidebar Automatic
Setting Detection and read Fix the “Incorrect Settings” Problem.

Added (or changed) in Mavericks:
✦

✦

✦

✦

iCloud account syncing: Use iCloud Drive to sync settings and
rules for all your email accounts (not just your iCloud account)
with your other Macs.
No more option to force plain-text messages: In previous
versions of Mail, a Terminal command forced all incoming or saved
messages to display in plain text, if available. Unfortunately for
lovers of plain text (like me), that command no longer works, and
the menu commands to switch among message formats are gone.
Gmail changes: Starting with Mavericks, Mail attempts to meet
Gmail on its own terms, with mixed success.
IMAP caching: Previously, you could choose, for IMAP accounts,
whether to download and cache full messages including attachments, only message text, only read messages, or none of the
above. Now, downloading the full text of every message is mandatory for IMAP accounts, though you can opt to skip attachments.

9
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Mail Changes in iOS 9
The iOS 9 version of Mail also contains several important new features
(not all of which are covered in detail in this book):
• Group addressing: I’ve long complained that it wasn’t possible
to address a messages to a group from Contacts. Now it is, although
not without some limitations. See Address a Message to a Group.
• Expanded attachment support: Mail always made it pretty easy
to add photos and videos to your outgoing messages, but attaching
other files was complicated. Now you can attach files from iCloud
Drive, Dropbox, OneDrive, Google Drive, and other sources without
ever leaving Mail. You can also save incoming attachments to any of
these places. See Handle Attachments.
• Additional swipe option: When you swipe left or right on a message in a mailbox view, you can now configure an additional option,
Move, which displays your mailbox list; tap a mailbox to move the
message there. Oh, and speaking of swipe gestures, they now show
icons (such as ) rather than text (such as Trash). See Use Swipe
Gestures.
• Markup: The Markup feature in OS X Mail has made its way to
iOS 9: you can now annotate graphics in outgoing email messages.
See Outgoing Attachments.
• Improved search: When using the search field, Mail now offers
suggestions (such as people and subjects containing your search
term) and, in some cases, a progress bar. See Search for Messages.
• More white space on iPad: When you view messages on an iPad,
you’ll notice that they have much larger left and right margins than
before (and they’re wider in portrait mode than landscape mode).
Apple presumably felt this would enhance readability.
• Slide Over: Like many (but not all) iOS 9 apps, Mail supports the
new Slide Over feature on iPads. This means you can swipe from the
right edge of the screen while Mail is open to see content from
10
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another app; conversely, while viewing another app, you can slide
over to see Mail. That way, you have access to more than one source
of data at a time.
• Go Back links: If you tap a link in Mail to open it in Safari, you’ll
see a Back to Mail link in the upper-left corner of the screen. Similarly, if you tap a link in Safari that opens an email message, you’ll
see a Back to Safari link. Whenever one app sends you to another,
this extra link makes it easier to get back to where you were.
• Low Power mode: If you go to Settings >Battery on an iPhone,
you can tap Low Power Mode to reduce background processes and
thereby extend your battery life. I mention that here because one
aspect of Low Power mode is that your iPhone stops fetching new
mail in the background.
• 3D Touch features: If you have a new iPhone 6s or 6s Plus, the
new 3D Touch capability lets you perform different actions depending on how hard you press on the screen.
‣ In Mail, you can press lightly on a message in any mailbox view
to preview it (a peek) and press harder to open it normally (a
pop). (And, while displaying the peek preview, you can swipe left
or right to see buttons such as Trash and Mark as Read/Unread.)
You can do the same thing with a contact’s profile photo and
other data.
‣ You can press on the Mail icon on your home screen to compose
a new message.
‣ In any app, including Mail, when you press on an on-screen
keyboard, it behaves like a trackpad, enabling you to position the
insertion point and select text more easily.
For more details, see Apple’s 3D Touch page.
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Noteworthy Changes in iOS 8
If you’re skipping straight from iOS 7 to iOS 9, you’ll want to be
aware of these Mail-related changes that happened in iOS 8:
✦

✦

✦

✦

✦

Expanded swipe controls: iOS 8 added new options (and
a degree of configurability) to the Swipe Left and Swipe Right
gestures in the message list, including a distinction between
short and long swipes. (iOS 9 expands on this.) See Use Swipe
Gestures.
Minimize new messages: iOS 8 made it possible to minimize
the message you’re composing to the bottom of the screen (and
you can even do so to multiple messages) to make it easier to
switch between what you’re typing and other messages. See
Minimize In-progress Messages.
Thread notifications: You can request to be notified when a new
message arrives in a specific thread. See Manage Notifications.
Contacts and Calendar shortcuts: Banners sometimes appear
at the tops of incoming messages with shortcuts for adding the
sender to Contacts or events to Calendar. See Use Calendar and
Contact Shortcuts.
Show nicknames and short names: As in El Capitan, this
setting gives you the option to show nicknames when available,
or to use a short version of a name (such as first name only,
or first initial and last name); the setting applies to both Mail
and the Contacts app. You can make any desired adjustments
in Settings > Mail, Contacts, Calendars > Short Name (in the
Contacts section).

Besides these major changes, iOS 8 Mail slightly changed the way
signed and encrypted messages were handled (see Sign and Encrypt
Messages in iOS 9), and added support for Zip archives (see Incoming Attachments).
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Learn about Email Protocols
The word “protocol” may sound complicated, but it’s just a way of
describing how your email program (in this case, Mail) talks to a mail
server. If you know a few basics about email protocols, you’ll have an
easier time understanding Mail’s interface and solving problems.
Although you may not be aware of it, most email accounts involve two
separate systems—one for receiving and another for sending—and
these often use entirely different servers. You probably use the same
username and password for each, but behind the scenes, each account
may function as two separate accounts:
• Your incoming account fetches email from your mail server and
delivers it to you using a mail delivery protocol—such as POP (Post
Office Protocol) or IMAP (Internet Message Access Protocol). Just
ahead, I explain more about POP and IMAP, I discuss common
IMAP and POP Misconceptions, and I offer guidance if you’re still
using POP and want to Switch from POP to IMAP (you probably
do). I also mention a few important points about iCloud and Gmail
accounts, both of which also use IMAP.
• Your outgoing account uses a mail transfer protocol called SMTP
(Simple Mail Transfer Protocol) to send email from your machine to
your mail server, and then (usually through a number of intermediate steps) to the recipient’s mail server.
Microsoft Exchange accounts are a bit different. They act like IMAP
accounts in many ways, but use a single—and an entirely different—
protocol for receiving and sending mail, as well as calendar items,
contacts, and other information.
Note: In this book I refer to IMAP (including iCloud and Gmail)
accounts and Exchange accounts, which manage and work with
messages on the mail server, as server-based accounts to distinguish
them from POP accounts, which store all retrieved messages locally.
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In this chapter I also discuss the concepts Fetch, Push, and IMAP
IDLE, which apply to multiple account types and affect how rapidly
your email client can find out about new messages.

POP
A POP account works like this:
• First, your client (that is, your email program) asks the server for
the list of messages in your Inbox.
• Then, depending on your client’s capabilities and settings, it downloads either all the messages, just the messages you select, or all
messages under a specified size, to your local device.
• Finally (and optionally), your client instructs the server to delete
the server copy of some or all of the messages.
The server doesn’t keep track of whether a message has been downloaded, read, or deleted; only your client knows this, and the assumption underlying the protocol is that you want to read, organize, and
store your mail on a single device, using the server only as a conduit to
receive your mail. If you want to store any messages in mailboxes other
than your Inbox, when you create those mailboxes in your email client,
they’re stored locally (not on the server); the messages you move to
these mailboxes are thus also stored locally.
You can usually set your client to leave messages on the server (rather
than delete them immediately after retrieving them) and then check
your email with a different client (or on a different device), but all
those messages will appear to be “new” and unread on every other
client or device. This, among other reasons, makes POP a poor option
if you work with email on multiple computers and devices.
In addition, although iOS supports POP, iOS Mail doesn’t let you
create new mailboxes to file messages locally. That means an iOS
device doesn’t work well as the sole device used with a POP account,
and because POP works best when used with a single device, this
mismatch of capabilities makes POP less than ideal for an iOS device.
14
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Master Mail Concepts
As I said in the Introduction, this book isn’t about basics, as such.
However, as I’ve corresponded with many Mail users over the years,
I’ve discovered that there are certain concepts that Apple hasn’t made
self-explanatory, and that therefore tend to trip people up. In order
to understand and act on much of the rest of this book, you need to
grasp a few concepts that are, perhaps, unnecessarily confusing. In this
chapter I walk you through the ones I consider most important.
Most of the items in this chapter pertain only to the El Capitan version
of Mail, but if you’re an iOS user, be sure to read Special Mailboxes,
much of which is also applicable to iOS.

Account Setup
Setting up new accounts in Mail has gotten easier in recent versions,
especially if you’re using one of the major email providers Mail already
knows about (iCloud, Exchange, Google/Gmail, Yahoo, and AOL)—
almost the entire procedure is automated. However, there are still a
few gotchas, especially if you’re using a different provider.

Pick a Preference Pane
For starters, there are two places where you can add, edit, or remove
accounts: in Mail > Preferences > Accounts and in System
Preferences > Internet Accounts (which you can also reach from within
Mail by choosing Mail > Accounts).
Why two places, and when should you use which?
• The reason for the Internet Accounts pane of System Preferences
is twofold. First, many account types (including iCloud, Exchange,
and Gmail) include more features than just email, and affect more
apps than just Mail, so Internet Accounts provides a central location
where you can enable or disable individual data types like Mail,
Calendars, Contacts, and Notes for each account. Second, some
25
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account types (like Twitter and Facebook) are used by OS X but
not by specific, built-in apps, and so it makes sense to provide one
central location to set up all these accounts.
• The reason for the Accounts pane of Mail preferences is, of course,
to make it more convenient to add an email account when you’re
already working in Mail—and because you may need to configure
any of numerous email account settings that are specific to Mail,
and that therefore would be inappropriate for Apple to put in
System Preferences.
You can add a new account to Mail in either place, and after you do
so, both locations will reflect that account. Beyond that, the Internet
Accounts preference pane gives you less control over the minute details
of email account settings than Mail’s Accounts pane does, although
there are a couple of things you can do only in Internet Accounts.
Here are the specifics:
• Mail’s Accounts pane: Visit this pane to edit outgoing (SMTP)
servers, add secondary From addresses, change the behavior of
Special Mailboxes, and adjust details such as whether to download
attachments, use an IMAP path prefix, or use IMAP IDLE (all in
the Advanced view).
• Internet Accounts pane of System Preferences: Use this to
enable or disable account features such as Calendars and Contacts,
delete any accounts synced via iCloud, or to set up Internet accounts
that don’t involve Mail.

Force POP or IMAP
When you create a new account (in Mail > Preferences > Accounts,
or in System Preferences > Internet Accounts), you start by clicking
the plus
button and selecting an account type. If the type you want
isn’t on that list (such as a standard IMAP or POP account), in Mail,
you select Add Other Mail Account and then click Continue; or in
Internet Accounts, you click Add Other Account, select Add a Mail
Account, and click Create. Then you fill in your name, email address,
and password.
26
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Customize Mail
Mail isn’t the fanciest or most powerful email client for the Mac, and
many people have dismissed it as being too unsophisticated for email
power users. I agree with that sentiment to a point—in its default
configuration, Mail isn’t a fantastic email program. However, you can
customize Mail in many ways, including by adding plug-ins that both
dramatically increase its capabilities and modify standard behaviors
to become much more useful. The result is that with a bit of effort, you
can turn a so-so email client into a deluxe and highly optimized tool.
In this chapter, I acquaint you with some of the most important ways
to customize Mail that don’t require any additional software. I don’t
list every single option, nor do I go into tremendous detail, but I want
to make sure you’re aware of what so many Mail users aren’t—you
don’t have to live with the stock version of Mail, and you can improve
your enjoyment of the app a great deal with a bit of grooming.
Note: Later, in Extend and Automate Mail, I discuss third-party plugins, AppleScript, Automator, and other ways of enhancing Mail.

Sidebar
The sidebar is the area on the left of Mail’s main window that contains
all your mailboxes. Don’t see it? Choose View > Show Mailbox List.
Prefer to keep it hidden? Choose View > Hide Mailbox List. (Apple
seems to think Mail is easier to use when the sidebar is hidden, but for
most people with multiple accounts or more than a few mailboxes, the
sidebar is indispensable.)
You can also rearrange items in the sidebar by dragging them to new
locations, with certain limitations:
• Top-level categories with titles in bold (such as Mailboxes, which
contains your Special Mailboxes; Smart Mailboxes; and individual
54
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accounts) can be reordered—for example, you might want to show
your smart mailboxes at the top of the list and your special mailboxes at the bottom.
• Within the Mailboxes category, the order of (unified) special mailboxes is fixed; for example, Drafts always appears above Sent.
However, you can reorder accounts within a unified special
mailbox. For example, if your Gmail account is listed before iCloud
under Sent, you can drag iCloud above Gmail—and that modified
order will be reflected under all your unified special mailboxes.
• You can reorder the mailboxes within any given account.
• You can click Show or Hide next to a sidebar category to expand or
collapse its contents (see Hidden Interface Elements), but you can’t
manually hide the categories themselves. On the other hand, Mail
automatically hides the names of accounts that have no sub-mailboxes beneath them.
Mail used to have a Mail Activity pane at the bottom of the sidebar. It’s
gone now, but an abbreviated version (Figure 10) appears briefly in
the same location when Mail is performing a background task that
takes more than a moment.

Figure 10: This mini activity monitor appears at the bottom of the
sidebar when Mail is busy doing something in the background that
might take a while. Notice the thin blue progress bar at the top.
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Extend and Automate Mail
In my opinion, the best thing about Mail is its extensibility. If I had
to use the plain, unadorned version of Mail as Apple provides it, my
productivity and happiness would decrease significantly—and I’d
probably switch to another app in short order. But with the addition
of a few third-party plug-ins and other tools, Mail becomes vastly more
versatile and powerful.
In this chapter I want to introduce you to some of the many ways you
can extend Mail’s capabilities. First, I’ll show you over 20 plug-ins that
can add or modify features. For anyone who needs to save and search
messages outside Mail, I next turn to apps that can Archive and Search
Messages, and then tell you about utilities to Remove Duplicate Messages. I wrap up the chapter with an introduction to the ways you can
Use AppleScript and Automator to automate Mail.
There’s a lot of information in this chapter, and I don’t want you to
think you need each product I mention. (In fact, some of them would
overlap and possibly conflict with each other.) Rather, my intention is
to acquaint you with a representative sample of the possibilities.
Joe’s Favorites
If you’re curious which of the tools from this chapter I use myself,
here’s my list of personal favorites:
✦

AppleScript

✦

CargoLifter

✦

DEVONthink (see Archive and Search Messages)

✦

GPGMail

✦

Mail Act-On

✦

MailTags

✦

QuoteFix

66

Click here to buy the full 207-page “Take Control of Apple Mail” for only $20!

Use Third-party Plug-ins
Scores of third-party Mail plug-ins exist. These enable you to change
unwanted behaviors, add new features, and enable significant new
customization options. For example, plug-ins can stop spam, encrypt
email messages, offer advanced message filing options, change the way
attachments are handled, modify Mail’s method of quoting text in
replies, and much more.
I’m not going to list every one of those plug-ins here (although I will
mention some places you can look to find more of them). The ones I’ve
selected for this book include those I use myself, ones recommended
by friends and colleagues, and others that seemed especially useful or
interesting (even if I have no need for them myself).
Some plug-ins come with their own installers. For those that don’t, all
you have to do is quit Mail, drag the plug-in to ~/Library/Mail/Bundles,
and restart Mail. (See Finding the User Library Folder if you need help
locating ~/Library.)
Plug-ins and OS X Updates
Although I love my Mail plug-ins, one thing I do not love is that
almost every time Mail (or OS X) is updated—no matter how tiny
or insignificant the update—every plug-in is disabled and must be
updated. Mail moves all plug-ins that it deems “incompatible” it to
~/Library/Mail/Bundles (Disabled), and moving them back won’t
reenable them.
What makes Mail think a plug-in is incompatible? Every version of
Mail has a special UUID (universally unique identifier), and unless
that UUID is included in a plug-in’s configuration files, the plug-in
won’t work.
Most of the time, plug-in developers respond by quickly releasing
new versions that add the new UUID, but if you can’t wait for an
official fix, try the free MailPluginFix, which adds the newest UUID
to any disabled Mail plug-ins. It doesn’t always work—sometimes
developers need to fix bugs or address deeper compatibility problems—but it often does, and it sure beats waiting.
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Use Gmail with Mail
If you have a Gmail account and want to use it in Mail under El Capitan, this chapter is for you. (For information on using Gmail in iOS 9
Mail, see Set Up Gmail as a Regular IMAP Account.) I cover the ways
Gmail in Mail differs from Gmail on the Web, the ways Gmail differs
from other IMAP providers, how best to configure Mail to use a Gmail
account, and how to avoid common problems. All of this, I hope, will
help make your experience of using Gmail in Mail as good as it can be.
Note: Everything in this chapter applies equally to standard Gmail
accounts and to Google Apps accounts with a custom domain name.

If you don’t use Gmail (or don’t want to use Mail to access Gmail),
there’s nothing to see here. Move right ahead to Find Your Messages.

Understand How Mail Works (or Not)
with Gmail
If you’re accustomed to Gmail’s Web interface, you may expect it to
work similarly in Mail. On the other hand, if you’re used to using Mail
with other IMAP accounts, you may expect Gmail accounts to behave
the same way. In both cases, the reality will differ quite a bit from your
expectation, and you’ll have an easier time using the combination of
Mail and Gmail if you know more up front about how the two systems
try (and sometimes fail) to work together. I’ll start by reviewing
changes Apple made to Mail’s behavior with Gmail accounts starting
in 10.9 Mavericks, then discuss Gmail on the Web vs. Gmail in Mail,
and finally turn to Gmail vs. Other IMAP Providers.
Note: Although Mail can also access Gmail via POP, I recommend
against it and don’t cover it in this book. Among other issues, with
POP, Mail can’t see archived Gmail messages or messages you’ve
sent from your Gmail account using the Web interface.
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How Mavericks Changed Mail’s
Gmail Behavior
Back in the Mavericks version of Mail, Apple made major changes
to the way Mail handled Gmail accounts, and those changes initially
resulted in some serious problems. Although Mail’s interactions with
Gmail are smoother now, its overall approach hasn’t changed since
then. If this is old news to you, feel free to skip ahead to Gmail on the
Web vs. Gmail in Mail. But if you never had much experience using
Gmail under Mavericks or Yosemite, you may find the changes surprising. The two biggest differences are as follows:
• No more duplicates: In earlier versions of Mail, if you left all
your Gmail settings at their defaults, Mail would download at least
two copies of each message—one in the All Mail mailbox and one
for each label you’d applied in Gmail (since labels in Gmail are
translated into mailboxes in Mail when you use IMAP). That made
for lots of duplicate messages, wasting bandwidth and disk space.
Now, Mail downloads just one copy of each message (the one in
All Mail), and invisibly “tags” each message to indicate which
other mailbox(es), if any, it should also appear in. That’s a better
approach, and it means there’s no longer any need, using settings
on the Gmail Web site, to hide the All Mail label from IMAP clients
(unless that’s essential for another IMAP client you also use)—and
in fact, Mail now works better if All Mail is enabled.
• Gmail-like archiving: Speaking of All Mail, the Archive mailbox
in Mail’s sidebar for Gmail accounts now shows All Mail—that is,
what you’d see if you clicked All Mail on the Gmail Web site. And
now, when you move a Gmail message to the Archive mailbox
(whether by dragging or by clicking the optional Archive button
on the toolbar), Mail removes the Inbox label so that the message
appears only in Archive (All Mail)—which, again, is exactly what
happens on the Gmail site. However, pressing Delete when you’re
viewing a Gmail message actually deletes it (that is, sends it to the
Trash mailbox); it does not archive the message as some Gmail
users might expect. If you dislike this behavior, see Delete2Archive
for a plug-in that changes it.
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Find Your Messages
OS X’s Spotlight search feature automatically indexes all your Mail
messages for super-fast searching, and you can search for them either
within Mail or using the system-wide Spotlight menu.
El Capitan adds the capability to search using natural language rather
than relying on special keywords or formulations. However, if you
want to do complex searches, you can—all the search capabilities from
Yosemite are still there too. With a flexible system of search tokens
(which I explain in a moment), Boolean searches, and other options,
you can find almost any message you can describe.
And, you can even save a search by converting it into a smart mailbox,
as I describe at the end of this chapter, in Work Smarter with Smart
Mailboxes.

Perform a Natural Language Search
Here’s a novel idea: when you’re searching for email, just describe
what you’re looking for in your own words. You can use plain English
(or plain whatever-language-you-speak) in Mail’s Search field, as well
as in system-wide Spotlight searches, to find email messages.
There’s no rulebook, no list of approved words or phrases. You just
describe what you want. Here are some examples:
•

emails from John Smith

•

messages to John Smith

•

messages with “split pea” in the subject

•

email with “split pea” in the body

•

email from John Smith in the last week

•

mail from Morgen including photographs

•

mail I ignored from Adam
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•

unread messages from this week

•

messages from bruce about security

There are countless other ways to search using natural language, but
the point is: don’t try to outthink Spotlight. Just ask the question that
you’re thinking.
Having said that, I should point out a few things I’ve noticed about
natural-language searches in El Capitan mail:
• Results aren’t always exhaustive. For example, if I ask for
unread messages, Mail shows me only recent unread messages.
You should not assume that because a message doesn’t show up
in a natural-language search, it doesn’t exist.
• Mail doesn’t care about your wording. Notice how, in the
examples above, I interchangeably used email, emails, mail, and
messages. Mail knows those all mean the same thing. So, don’t get
hung up on picking exactly the right term.
• Mail is smart, but it can’t read your mind. If you search for
messages from “Bob,” you may have a particular person in mind,
but Mail doesn’t know which of the many Bobs in your saved mail
you’re interested in. Be more specific if the results aren’t what you
want.
• Searches may take a while. Although Mail starts returning
search results immediately, it continues to search until it’s gone
through all your mail; sometimes that can take a while. So if you
don’t see the messages you’re looking for right away, give it a few
seconds (or more).
If a natural-language search doesn’t turn up what you’re looking for,
you can always fall back to the old-fashioned way. For starters, you
can perform a conventional search (discussed next); for even greater
power, you can Search for a Phrase, Use Boolean Expressions, or
Search by Date Range. And, even in a natural-language search, you
can use the techniques discussed later in this chapter to narrow the
search field.
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Take Control of Your Inbox
Does your Inbox contain hundreds of messages? Thousands? Tens
of thousands? If so, you may find it nearly impossible to tell which
messages you’ve dealt with and which still require action, and finding
a particular message in that long list may be a daunting challenge.
You need to take control of your Inbox!
Although everyone’s different, I’d like to offer some suggestions that
will help you manage the flow of incoming messages. I don’t particularly care whether you do things my way, but please think carefully
about the types of messages you receive and come up with a plan to
deal with them that works for you.
I begin this chapter with a series of pointers that apply equally to El
Capitan (and other desktop platforms) and iOS. Then I discuss specific
approaches for each platform in Develop an Email Strategy.

Take Responsibility
The first step to taking control of your Inbox is recognizing that you,
and only you, bear the responsibility for making your own email
manageable. If you feel overwhelmed by email, don’t point the finger
at email as a medium—or at Apple Mail, your email provider, or your
correspondents. You can make email work for you, but as with a diet
or fitness program, it requires time, effort, and perhaps discomfort
on your way to success. No app, service, or technique can do all that
for you magically, even though such things can certainly help a bit.
As I said in my TidBITS article It’s Not Email That’s Broken, It’s You,
email as such isn’t the problem, but rather the bad habits many people
have gotten into when it comes to dealing with their email. Perhaps
your mother, like my mother, was fond of saying, “This room isn’t
going to clean itself up!” By the same token, I can assure you that elves
will not appear overnight and answer all your delinquent email, file it
away for you, and leave you with an empty Inbox. If you want to feel
105

Click here to buy the full 207-page “Take Control of Apple Mail” for only $20!

in control of your Inbox, that’s going to require some reflection,
experimentation, and changes in habit.
So, although I can’t solve this problem for you, I can offer some tips
and suggestions that, I hope, will point you in the right direction.
That’s what the remainder of this chapter is about.

Consolidate Your Accounts
Since you’re reading this book, I assume you have at least one email
account. Maybe you have two (personal and work)—or maybe, like me,
you have more than a dozen. My excuse is that I need to have accounts
for each major type and provider (including IMAP, POP, iCloud,
Exchange, Gmail, AOL, Outlook.com, and Yahoo) for testing purposes
because I write about email. But I know lots of people who accumulate
accounts (especially free accounts) for no particular reason and then
end up wasting time and effort checking, managing, and maintaining
them all.
So, allow me to make a few suggestions to make your life simpler and
to make Mail in OS X and iOS work better.
Begin by choosing one account to be your primary personal email
account. (Of course, you may need to keep work email separate, and
that’s entirely reasonable.) Then, rather than send out change-ofaddress notices to anyone who might have each of the other addresses—assuming you can even remember who has which one—visit the
Web interfaces for all other accounts, set them up to forward incoming
messages to your central account, and disable those accounts in Mail
on your Macs and iOS devices.
Once you’ve performed this one-time procedure, your correspondents
can keep using your old addresses, but you benefit by having just one
place to check for incoming mail and one place to store the messages
you want to save. Having fewer accounts to check will make Mail
peppier, too.
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Become a Better
Correspondent
In the previous chapter, Take Control of Your Inbox, I looked at the
ways you can improve your management of incoming email. In this
chapter we look at the flip side: handling outgoing email. I felt it was
important to spend a few pages on this topic, because anyone who
doesn’t exercise care in sending email becomes part of the problem
for other people dealing with their incoming mail.
Lots of people are bad at email—you can probably think of a few
examples immediately—and I want to make sure you’re not one of
them. But even if you’re fantastic at sending email, I hope the points
I make in this chapter help you to set a good example and teach other
people how to improve their email skills.

Don’t Be Part of the Problem
The most common mistakes people make when sending email aren’t
premeditated or malicious; they’re simply a matter of not thinking
things through—of not looking at email from the recipient’s point of
view. If your guiding principle is to send only email messages you’d be
happy receiving yourself, you’re already well on your way to being a
better correspondent.
But what counts as email courtesy isn’t always obvious, so let me offer
several specific tips:
• Use Bcc for lists: A few times a month, I receive an email message
sent to all the parents of my child’s preschool by a member of the
parents’ association. And all 108 addresses are in the To field, which
means I have to scroll past them when viewing the messages on my
iPhone before I get to the message body. It also means I know the
email address of every other recipient, which not everyone is comfortable sharing publicly.
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When sending a message to multiple people—especially a long list,
and even more especially when they don’t know each other—put
your own address in the To or Cc field, and put all the recipient
addresses in the Bcc (blind carbon copy) field (see Message
Header). That way, each recipient’s address is hidden from the
other recipients. And they’ll thank you for it.
• Be careful with Reply All and Cc: Suppose you’re the recipient
of a message sent to multiple people, and their addresses are in the
To or Cc fields. You might be tempted to click Reply All out of habit,
but please think before you do. Does everyone else on that list really
need to hear what you have to say, or just the sender? Or perhaps a
subset of the recipients? You can individually delete email addresses
when replying to all, and more often than not, replying to everyone
on a long list amounts to unwanted clutter for most of them.
Similarly, think before adding someone as a Cc recipient. People
regularly Cc me on complaints, bug reports, and other matters that
vaguely involve a book or article I’ve written, but really: I don’t need
to be involved, and I assure you that putting my name on a message
you send to Apple (or whomever) won’t lend it any more weight.
Ask yourself whether the potential Cc recipient truly needs to be
involved in a discussion.
• Don’t forward nonsense: Jokes, funny animal pictures, political
screeds, and other such stuff that gets endlessly forwarded is nearly
as bad as spam. You can’t stop someone from sending this material
to you (although you can ask politely), but you can certainly make
sure you’re the last link in the chain. Seriously, no matter how funny
or apt you find one of these generic messages, your friends and
family don’t need to read it.
Tip: A subspecies of “nonsense” is the urban myth, a breathless story
about some supposed tragedy, scandal, or other atrocity that sounds
plausible, but is in fact false. Sometimes it’s hard to know whether
a story is fact or fiction, and if in doubt, a good place to check is the
Web site Snopes.com.
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Sign and Encrypt Messages
Back in Signatures, I explained how to add a signature to the end of
each message with your contact information, a quote, or other content.
But a message can also have a digital signature, a (normally invisible)
string of characters that confirms to the recipient that the message
truly comes from the address it appears to come from, and that the
message contents haven’t been altered in transit.
In addition, Mail can encrypt messages, scrambling their contents so
that only someone with the necessary key (presumably, the recipient)
can view their contents, thereby ensuring private communications.
In this chapter I discuss if and when you should use digital signatures
and encryption, how they work behind the scenes, and how to go about
signing and encrypting messages in Mail.

Learn When and Why to Sign or
Encrypt Messages
Let me start with the essential question of whether, or under what
circumstances, you should even think about signing or encrypting
messages. It’s not something everyone needs to do, and if you never
need to do it, you need not bother reading the rest of this chapter. But
the need could arise at some point—and even if you don’t need to sign
or encrypt, you may find that there are some benefits to doing so.
Note: One could argue that even though most email doesn’t need to
be encrypted, using encryption routinely (even when not needed) is a
smart idea. If you encrypt only certain messages, that could suggest
to an attacker that you have something to hide, and that those
encrypted messages are where it’s hidden.

Most of us are accustomed to thinking of email as being private. One
person sends a message and someone else receives it; as long as no
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one is looking over either person’s shoulder or snooping on their
computers when they’re not around, we presume that whatever was
in that message is known only to the sender and recipient.
Indeed, that’s how things work most of the time, just as with paper
letters: Most of the time no one except the intended recipient opens
a letter to see what’s inside. But mail theft, tampering, accidents,
and honest mistakes do occur. It sometimes happens that a person
who shouldn’t see what’s inside an envelope, does. And when the
contents of that envelope are highly confidential, sensitive, or valuable,
someone else reading your mail can become a serious problem indeed.
Email is no different. It should be private, but it isn’t always. Each
message exists not only on the computers of the sender and recipient,
but also (at least temporarily) on each party’s mail server. In addition,
a message may pass through any number of intermediate servers and
routers, and may be backed up along the way in the data centers of
one or more ISPs. In any of these places, a message could be read by
an employee of the ISP, and it could be intercepted in transit by a
hacker—or a government agency—during its journey from sender to
recipient.
(“Doesn’t SSL encrypt my messages?” you may ask. SSL secures a
message only between Mail and the incoming or outgoing mail server,
but doesn’t prevent someone from reading that message while it’s on
a mail server, or during other legs of the delivery process.)
Because so many millions of email messages are exchanged every day,
the probability that any particular message you send or receive will be
read by someone who shouldn’t see it is incredibly small—but not zero.
So, consider what would happen in one of these situations if the wrong
person read email you sent:
• You need to email your accountant detailed information about your
income, expenses, and taxes.
• You need to provide someone with your credit card number, social
security number, or other sensitive information by email.
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Fix Mail Problems
Even though Mail in El Capitan is more reliable than its predecessors,
problems will still occur. I’ve compiled solutions to some of the most
common (and serious) problems in the pages ahead, including difficulties receiving and sending mail, problems with damaged mailboxes,
and misbehaving Spotlight searches.
Although some of this information may provide useful background
for resolving iOS Mail issues too, the specifics are different; see Troubleshoot iOS Mail Problems for help with Mail in iOS 9.

Fix Incoming Mail Problems
If Mail cannot download incoming messages, the cause may be anything from an incorrect setting in Mail, to a server problem, to a loss
of Internet connectivity. Work through each of the following sections
until you resolve the problem.
About the Activity Window
To check what Mail is doing behind the scenes, choose Window >
Activity. A small floating window appears, displaying detail about
each activity Mail is performing. If there’s only one activity (and, in
El Capitan, I’ve never seen more than two at once), the mini activity
monitor at the bottom of the sidebar shows the same information.
And, in El Capitan, the Activity window no longer lets you cancel
tasks, as was previously the case.
For these two reasons, there’s little point in using the Activity window
anymore—just look at the mini activity monitor in the sidebar.

Try Connection Doctor
To open Connection Doctor, choose Window > Connection Doctor. In
the Connection Doctor window, Mail lists each incoming and outgoing
email account you’ve configured—even those you’ve temporarily
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disabled. It attempts to log in to each account, and if it fails with any
of them, it shows an explanation of why it failed. These explanations
aren’t always helpful, but they often give you a good starting point
in debugging problems, and are written in refreshingly plain English.
If the Connection Doctor window suggests a specific fix, try that first.
Otherwise, proceed with the following steps.

Username and Password Errors
If you enter your password in Mail > Preferences > Accounts (or in
System Preferences > Internet Accounts), El Capitan stores the password in your keychain (which is usually what you want). If, for security
reasons, you prefer for Mail to prompt you for your password each
time you connect, leave the Password field blank.
Sometimes, even after successfully checking your email many times
with the password you entered, Mail displays a dialog claiming that
the mail server has “rejected” your password. Worse, you may re-enter
your password—and even select Remember This Password in My
Keychain—but find that another error message pops up as soon as you
click OK. This annoyance may be due to any number of causes, but
most have simple solutions.
If Mail suddenly begins prompting you for your password repeatedly
when checking incoming mail (after retrieving it correctly earlier), try
these steps in order until the problem goes away:
1. Click Cancel, and then check your email again in a minute or two.
Sometimes the problem goes away on its own. (If your account is
offline, choose Mailbox > Take All Accounts Online.)
2. Check your keychain. To do so, open Keychain Access, which you
can find in /Applications/Utilities. Choose Keychain Access >
Keychain First Aid. Click the Repair radio button, enter your administrator password, and click Start. If the keychain file had an error,
Keychain First Aid will fix it.
3. If the problem persists, return to Keychain Access. Make sure that
Passwords or All Items is selected under Category, locate your mail
server in the list (for iCloud accounts, the entry’s name should show
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Use Mail in iOS 9
So far, the bulk of this book has been about El Capitan Mail. Although
I’ve mentioned iOS 9 Mail from time to time (and some of the things
I’ve discussed apply equally to both platforms), Mail in iOS 9 has
enough unique characteristics that it deserves its own chapter. As was
the case for El Capitan Mail, I’m not going to cover every feature here.
Instead, I want to point out the most important things you need to
understand in order to use iOS 9 Mail effectively—especially aspects of
Mail that are unclear, obscure, or otherwise confusing.
I begin with a list of the key differences between iOS 9 Mail and OS X
Mail. Then I move on to 15 Things Every iOS Mail User Should Know
and wrap up with how to Troubleshoot iOS Mail Problems.

iOS 9 Mail vs. OS X Mail
Mail in iOS 9 shares a great deal in common with Mail in El Capitan,
so anyone accustomed to one platform should be able to pick up the
other easily. Naturally, the iOS version makes accommodations for
smaller screens, a touch-screen interface, and the numerous iOS user
interface conventions that differ from those of OS X. I won’t spell all
those out here, but I do think it’s worth pointing out several key
differences in functionality—as well as a few similarities you may not
have noticed.
Here’s what you should know about the iOS 9 version of Mail:
• No rules or spam filtering: If you want to sort messages or weed
out junk mail automatically, it’s best to set these tasks up on your
mail server. (See Use Rules and Control Spam, respectively.)
• Push (but no IMAP IDLE): Mail in iOS supports push delivery
of messages from iCloud, Exchange, and Yahoo IMAP accounts—
and push works even when Mail isn’t open (see Fetch, Push, and
IMAP IDLE). However, IMAP servers that offer only IMAP IDLE
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as a way of “pushing” messages don’t give you push delivery on
an iOS device. As a result, Mail in El Capitan is likely to display
messages from such servers before Mail in iOS 9.
Push delivery, where applicable, works with your Inbox and—for
iCloud and Exchange accounts only—with other mailboxes you
explicitly set up (see Change Account Settings).
In addition, note that even with iCloud and Exchange accounts,
although Mail pushes new messages to your device immediately,
it does not push changes made on other devices, such as moved
or deleted messages. So, if your iOS 9 Mail icon says you have one
unread message, and you delete that message on your Mac, the “1”
badge won’t disappear right away; you may need to open Mail to
force it to resynchronize its Inboxes.
• Limited mailbox syncing: Related to the last point…whereas the
El Capitan version of Mail caches complete copies of all messages in
all IMAP and Exchange mailboxes, syncing them in the background,
iOS 9 Mail doesn’t (which is a good thing, because that would chew
up lots of cellular bandwidth and storage space).
Instead, for IMAP accounts, Mail syncs only the Inbox in the background. For Exchange accounts, you can specify how far back to
sync email messages (from a day to a month, or all messages), and
as I mentioned in the last point, you can select, for iCloud and
Exchange accounts, which mailboxes should have their messages
pushed to your device. As for any other mailboxes, Mail syncs them
only when you tap on them to display their contents.
This may be significant if you use server-side filters or rules to sort
your messages into mailboxes, because mailboxes other than Inbox
won’t indicate that they contain any new, unread messages until you
manually select them.
• Autocomplete for multiple addressees: If you regularly send
messages to the same set of addresses (for example, your spouse
and your mother), Mail notices this and offers the combination of
addresses as an option when autocompleting a partial address (in
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About This Book
Thank you for purchasing this Take Control book. We hope you find
it both useful and enjoyable to read. We welcome your comments.

Ebook Extras
You can access extras related to this ebook on the Web. Once you’re
on the ebook’s Take Control Extras page, you can:
• Download any available new version of the ebook for free, or buy
a subsequent edition at a discount.
• Download various formats, including PDF, EPUB, and Mobipocket.
(Learn about reading on mobile devices on our Device Advice page.)
• Read the ebook’s blog. You may find new tips or information, as
well as a link to an author interview.
• Find out if we have any update plans for the ebook.
If you bought this ebook from the Take Control Web site, it has been
automatically added to your account, where you can download it in
other formats and access any future updates. However, if you bought
this ebook elsewhere, you can add it to your account manually:
• If you already have a Take Control account, log in to your account,
and then click the “access extras…” link above.
• If you don’t have a Take Control account, first make one by following the directions that appear when you click the “access extras…”
link above. Then, once you are logged in to your new account, add
your ebook by clicking the “access extras…” link a second time.
Note: If you try these directions and find that your device is incompatible with the Take Control Web site, contact us.
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Shameless Plug
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ebooks on topics such as backing up and maintaining your Mac. I’d be
delighted if you stopped by for a visit! You can also sign up for joeMail,
my free, low-volume, no-spam mailing list, or follow me on Twitter
(@joekissell). To learn more about me personally, visit JoeKissell.com.
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This is but one of many Take Control titles! Most of our books focus
on the Mac and OS X, but we also publish titles that cover iOS, along
with general technology topics.
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Caveat lector: Although the author and TidBITS Publishing Inc. have made a reasonable
effort to ensure the accuracy of the information herein, they assume no responsibility for
errors or omissions. The information in this book is distributed “As Is,” without warranty
of any kind. Neither TidBITS Publishing Inc. nor the author shall be liable to any person
or entity for any special, indirect, incidental, or consequential damages, including without
limitation lost revenues or lost profits, that may result (or that are alleged to result) from
the use of these materials. In other words, use this information at your own risk.
It’s just a name: Many of the designations in this ebook used to distinguish products
and services are claimed as trademarks or service marks. Any trademarks, service marks,
product names, or named features that appear in this title are assumed to be the property
of their respective owners. All product names and services are used in an editorial fashion
only, with no intention of infringement. No such use, or the use of any trade name, is
meant to convey endorsement or other affiliation with this title.
We aren’t Apple: This title is an independent publication and has not been authorized,
sponsored, or otherwise approved by Apple Inc. Because of the nature of this title, it uses
terms that are registered trademarks or service marks of Apple Inc. If you’re into that sort
of thing, you can view a complete list of Apple Inc.’s registered trademarks and service
marks.
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